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    LLiicceennssee  AAggrreeeemmeenntt  
CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS PROGRAM. USING 
THIS PROGRAM INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO NOT 
ACCEPT OR UNDERSTAND THEM, YOU SHOULD PROMPTLY RETURN THIS PRODUCT TO YOUR VALUE-
ADDED RESELLER OR DEALER. 

The export and re-export of Pinnacle software products are controlled by the United States Export 
Administration Regulations and such software may not be exported or re-exported to any country to which 
the United States embargoes goods. In addition, Pinnacle software may not be distributed to persons on 
the Table of Denial Orders, the Entity List, or the List of Specially Designated Nationals. 

By downloading or using a Pinnacle software product you are certifying that you are not a national of any 
country to which the United States embargoes goods and that you are not a person on the Table of Denial 
Orders, the Entity List, or the List of Specially Designated Nationals. 

PPrroopprriieettaarryy  PPrrooppeerrttyy  
This product, Pinnacle Systems’ trademarks, product names, user manuals, documentation and other 
support materials are either patented, copyrighted, trademarked, constitute valuable trade secrets 
(whether or not they or any portion thereof may be copyrighted or patented) or are otherwise proprietary 
to Pinnacle Systems. In addition, this program may contain the proprietary property of others which has 
been licensed to Pinnacle Systems (such as utility or plug-in software or programs, clip art and sample 
files). You agree not to remove any product identification or notices of the proprietary restrictions from 
Pinnacle Systems’ products or manuals. 

LLiicceennssee  aanndd  PPrroohhiibbiittiioonnss  
You may: 

(a) use the enclosed program and accompanying written materials (“programming materials”) in 
connection with a single computer. A copy of the program is being furnished to you along with this 
license agreement. If you wish to use this program on more than one computer, you must license 
additional copies of the program; 

(b) use the program and accompanying written materials on a licensed computer network. A “computer 
network” is any combination of two or more terminals or computers that are electronically linked and 
capable of sharing the use of a single software program. A “licensed computer network” is a computer 
network for which you have purchased from Pinnacle Systems, or its dealer, sufficient copies of this 
program so that the number of concurrent users of this program on the computer network at any 
given time is not greater than that number of copies of the program so purchased; 

(c) Copy the program once only solely for backup purposes in support of your use of the program so long 
as you prominently label the backup copy with the appropriate copyright notice; 

(d) use the program for your personal use or in your business or profession. Permitting unauthorized 
users access to the program and program materials is a violation of this license agreement; and  
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(e) transfer the program and license to another party if the other party agrees to accept the terms and 
conditions of this agreement. If you transfer the program, you must at the same time either transfer 
all copies to the same party or destroy any copies not transferred. If you transfer possession of any 
copy of the program to another party, your license is automatically terminated. 

PPrroohhiibbiitteedd  UUsseess  
You may not, without explicit prior written permission from Pinnacle Systems: 

(a) use, modify or transfer the program, or copy the program in whole or in part, except as expressly 
provided herein; 

(b) reverse-engineer, decompile or otherwise recreate the program or hardware in whole or in part; 

(c) make copies of or distribute, for profit or otherwise, or authorize the copying or distribution of the 
program, hardware, or materials related thereto, except as herein provided; 

(d) make alterations to the program or merge it into any other software; 

(e) grant sublicenses and leases or other rights in the program or program materials to others; 

(f) make verbal or media translations of the program, in whole or in part, or of the program materials; 

(g) modify the program for use on non-compatible hardware; 

(h) make telecommunications data transmissions of the program in whole or in part; 

(i) distribute the program on either a permanent or temporary basis to others; 

(j) make available any part of the program or program materials to any third party, other than your own 
properly authorized employees; or 

(k) make any alteration, modification, connection, disconnection, improvement or adjustment of any kind 
to or use the Pinnacle Systems DV500 hardware except as explicitly contemplated in the enclosed 
programming materials. 

It is agreed that the violation by you of any of the prohibitions described above shall be a material 
breach by you of this license agreement, and any attempt to sublicense, assign, or transfer any of the 
rights, duties, or obligations under this agreement, except as expressly provided herein, is void. 

TTeerrmm  
The license is effective until terminated. You may terminate it at any time by destroying the program 
together with all copies in any form. It will also terminate upon conditions set forth elsewhere in this 
agreement or if you fail to comply with any term or condition of this agreement. You agree that upon such 
termination you will destroy the program together with all copies in any form. 

LLiimmiitteedd  WWaarrrraannttyy  
The program is provided „as is“ without warranty of any kind, either expressed or implied, including but 
not limited to the implied warranties of merchantability and fitness for a particular purpose, with the sole 
exception of defective diskette(s) and Pinnacle Systems DV500 hardware, described below. The entire risk 
as to the quality and performance of the program is assumed by you. If the program proves defective, you 
(and not Pinnacle Systems, its Licensors, or its dealers) assume the entire cost of all necessary servicing, 
repair or correction. 
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Pinnacle Systems warrants to the original licensee that Pinnacle Systems DV500shall be free from defects 
in material and workmanship only for a period of thirty (30) days from the date of original purchase. If a 
defect covered by this warranty occurs during this period, and it is returned to the dealer from whom it 
was purchased not later than five (5) days after the end of such period, the dealer shall, at its option, 
either repair or replace the item. This warranty is in lieu of all other express or statutory warranties, and 
the duration of any implied warranty, including but not limited to the implied warranties of merchantability 
and fitness for a particular purpose, is hereby limited to said thirty (30) day period. 

Pinnacle Systems warrants to the original licensee that Pinnacle Systems DV500 shall be free from defects 
in material and workmanship only for a period of one (1) year from the date of original purchase. If a 
defect covered by this warranty occurs during this period, the licensee may request a Return Material 
Authorization (RMA) number from Pinnacle Systems. Upon receipt of the returned item(s), Pinnacle 
Systems shall, at its option, either repair or replace the item(s). Items returned to Pinnacle Systems 
without RMA numbers will not be accepted. This warranty is in lieu of all other express or statutory 
warranties, and the duration of any implied warranty, including but not limited to the implied warranties of 
merchantability and fitness for a particular purpose, is hereby limited to said one (1) year period. 

Pinnacle Systems’ and its Licensors’ liability is limited solely to the repair or replacement of the enclosed 
media and Pinnacle Systems DV500 hardware, as set out above, and shall not in any event include 
damages for loss of use or loss of anticipated profits, savings, costs, expenses or other incidental or 
consequential damages arising out of the use or inability to use the program, including without limitation, 
any damages arising from data or information lost or rendered inaccurate, regardless of the form of action 
whether in contract, tort (including negligence), strict product liability or otherwise, even if Pinnacle 
Systems, its Licensors, or its dealer has been advised of the possibility of such damages. 

Pinnacle Systems and its Licensors do not warrant, guarantee or make any representations that the 
functions contained in the program will meet your requirements or that the use or operation of the 
program or that the results of such use will be correct, accurate, reliable, current, uninterrupted or error 
free; and you rely on the program and results of its use solely at your own risk. 

Some jurisdictions do not allow the exclusion or limitation of implied warranties, so the above exclusion 
and limitation may not apply to you. Some jurisdictions do not allow the exclusion of liability for incidental 
or consequential damages so the above exclusion may not apply to you. This warranty gives you specific 
rights and you may also have other rights which vary from jurisdiction to jurisdiction. 

UUppddaatteess  
Periodically Pinnacle Systems may introduce new versions or releases of the software. To qualify for 
notification of the availability of these new versions or releases and their prices, you must first complete 
and return the enclosed program registration card. All new versions or releases which are provided to you 
shall become part of the program and shall be governed by the terms of this license agreement. 
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  IInnttrroodduuccttiioonn  
Thank you for purchasing Hollywood FX. Hollywood FX gives you an incredible 
collection of 3D transitions that you can quickly add to your video productions, and 
customize completely for your needs. This chapter will introduce you to Hollywood 
FX, provide instructions for installation and give contact information for customer 
support. 

This Getting Started Guide is provided for Hollywood FX Copper, Bronze, Silver, 
and Gold.  This guide will provide you the information you need to get started with 
Hollywood FX in your host application, as well as provide some basic tutorials to get 
you started selecting and using different 3D FX.  

In addition to this guide, Bronze, Silver, and Gold users will find an Advanced 
Tutorials guide and Reference guide for your software on the CD-ROM.  When you 
insert the CD-ROM, the Welcome dialog will give you the option of viewing and 
printing the additional documentation. 
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WWhhaatt  iiss  HHoollllyywwoooodd  FFXX??  
Hollywood FX is an incredible collection of true 3D transitions that you can quickly 
use in any video production. Hollywood FX works as an integrated plugin to your non-
linear editing software (host application).  With Hollywood FX you get easy controls, 
powerful customization, and great features: 

• True 3D.  Hollywood FX uses OpenGL to provide hardware accelerated, high 
quality 3D rendering. 

• Easy To Use.  Simply drag-and-drop Hollywood FX into your timeline like any 
other transition.  The Hollywood FX dialog will appear and you can select a 
transition and change your options. 

• Organized.  Transitions are organized into convenient categories with icons 
that let you find the transition you want quickly. 

• Convenient Control.  With every transition you can change the flight 
direction, lighting, shadows, shine and antialiasing with the click of your 
mouse. 

• Keyframe Editing (Bronze, Silver, Gold). Edit individual object flight paths, 
and dozens of parameters with the powerful keyframe editor. Hollywood FX 
Silver and Gold provide incredibly advanced keyframe editing features. 

• Create Your Own FX (Silver, Gold). Completely customize any existing FX or 
start from scratch to create entirely new FX. 

• Advanced Animation (Gold). You have full editing control over the camera, 
lights, texturing, and much more.  

• 3D Compositing.  Hollywood FX Silver includes plugins for basic 3D 
compositing and 3D object warping, while Hollywood FX Gold comes with a 
complete complement of plugins for advanced compositing and 3D object 
warping for amazing results. 

• MultiWindow Excitement. Hollywood FX Bronze supports FX with up to 7 
video sources, Silver supports 30 video sources, and Gold is unlimited.  
Create cubes with different video sources on each side, and much more. 

• Expandable. Add new transitions at any time with our Club Volume CD-ROMs 
and from Club Hollywood, the Internet effects mall. In addition Hollywood FX 
Silver and Gold can be expanded with image filter and 3D object warping 
plugins.  The possibilities are infinite. 
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BBeeffoorree  YYoouu  SSttaarrtt  
Before getting started with Hollywood FX you should have a good working knowledge 
of your Macintosh or Windows system.  You should be able to use the mouse to 
select menu options and should understand and be able to use the common controls.  

You should also be thoroughly familiar with your video editing software.  You should 
be able to use clips in the timeline and understand how to add and modify 
transitions. 

Throughout this document we use the term FX to refer to the transitions and effects 
in Hollywood FX.  This term generically describes the following types of transitions 
and effects: 

• Transition.  These are standard A-B transitions, where one video source 
transitions into a second. 

• Transition+ (Bronze, Silver, Gold) These are also A-B transitions; however, they 
may have additional video channels that can be mapped with video.  For 
example, the FlipOver FX features the first video source flipping over like a card 
to reveal the second video source.  There is a third video source that is visible in 
the background as the “card” flips over. 

• MultiWindow (Bronze, Silver, Gold) These effects are not transitions at all.  
Instead, windows of video may fly on or off the screen into various positions 
while playing your video. 
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IInnssttaallllaattiioonn  ffoorr  WWiinnddoowwss  9988,,  NNTT  44,,  WWiinnddoowwss  22000000  
Before installing Hollywood FX, verify that you have the correct minimum 
requirements: 

• PC compatible with at least a Pentium 166 MHz processor (or compatible 
equivalent). 

• Windows NT 4.0 with Service Pack 3 or higher, Windows 98, or Windows 
2000. 

• 64 MB RAM (more may be required by your video editing software) 
• At least 20 MB Hard Disk space. 
• 16 or 24 bit display adapter.  3D Accelerator recommended. 

··  TToo  iinnssttaallll  HHoollllyywwoooodd  FFXX::  
F Insert the Hollywood FX CD into your CD-ROM drive.  The CD-ROM Welcome dialog will 

appear. 
F Enter the serial number that came with your software (it can be found on the first page 

of this guide or on the CD-ROM sleeve). Enter the serial number exactly as shown, 
including dashes, then click Ok. 

F The Main Installation menu for your software will appear. 
F Select Install Hollywood FX.  The installer will load, and the Setup Welcome dialog will 

appear. 
F Click Next to continue.  The Setup Registration dialog will appear.  Enter your name and 

organization (the serial number should already be filled in).  Click Next to continue.  The 
License Information dialog will appear. 

F Please note your serial number and machine id.  You will need these to register and 
receive your permanent keycode.  Click Ok to continue. The Setup Path dialog will appear. 

F Normally you should accept the default path for installation.  Do not select your non-
linear editor’s plug-in path for installation; the installer will automatically install the files 
needed into your non-linear editor’s folders.  Click Next to continue.  The Select Host 
Plugins dialog will appear. 

F Click on the checkboxes for any host applications that the installer should search for and 
install a Hollywood FX plugin.  Click Next to continue.  Hollywood FX will be installed on 
your system.  When finished, the Setup Complete dialog will appear. 

F Click Close to exit setup and start the FXmark benchmark and configuration utility. 
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FFXXmmaarrkk  
(Bronze, Silver, Gold) After installation, the FXmark utility is run.  This utility will test 
your system for 3D rendering capability and adjust Hollywood FX settings to best 
take advantage of your system.   Generally, you will simply click Start to begin the 
automated testing.   

AAcccceelleerraattoorr  HHaarrddwwaarree  
FXmark will attempt to take advantage of any OpenGL hardware accelerator installed 
in your system for .  For more information on specific accelerator hardware 
compatibility go to the Support section at http://www.hollywoodfx.com. 

WWhhaatt  TToo  DDoo  IIff  FFXXmmaarrkk  FFaaiillss  
If FXmark crashes during operation, you should begin by verifying that you have the 
latest software updates for your operating system, and particularly your graphic card 
driver.  After making sure all drivers are current, run FXmark again from the Start 
menu. 

If FXmark still crashes, run it again then exit immediately without running any tests 
(click on the close button at the top right of the FXmark dialog.  FXmark will use 
software-only rendering which will generally eliminate any problems. 

FFXXmmaarrkk  RReessuullttss  
At the end of testing, the complete test results are displayed.  Here you can see how 
well your system performed and what default settings were adjusted.  If you would 
like to see how your system compares with others, you can compare your results 
online at http://www.hollywoodfx.com/products/fxmark. 

FFXXmmaarrkk  OOppttiioonnss  
When FXmark is started, you will see two checkboxes that you can use to change 
how FXmark is run. 

Pause Between Each Test.  Normally FXmark runs all tests without pausing.  By 
checking this box you can stop and view the result of each test, and use the Skip 
button to skip any test.  

Run Additional Tests.  FXmark contains additional benchmarks that are not run for 
normal configuration.  Check this box to include the additional tests in FXmark 
testing. 
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OObbttaaiinniinngg  YYoouurr  PPeerrmmaanneenntt  LLiicceennssee  KKeeyyccooddee  
After installation you can use Hollywood FX for 30 days before the temporary license 
expires.  You must register to obtain a permanent license keycode for your software.  
During installation your unique machine id will be displayed which must be provided 
along with your serial number during registration.  In return you will receive a 
keycode that can be entered by selecting Programs->Hollywood FX ->Enter 
Your Permanent Key Code from the Start menu. 

You can register your software and obtain your keycode any of the following ways: 

Via the web:  http://www.hollywoodfx.com 
By Email:  register@hollywoodfx.com 
By Phone:  1-801-281-0237 
By Fax:  1-801-281-0238 
By Mail:  Hollywood FX Registration 
   Pinnacle Systems 

300 East 4500 South Suite 100  
   Salt Lake City, UT 84107 

You must provide the following minimum information when you register.  Your Name, 
Company Name, Address, Phone Number, Serial Number, and Machine ID.  The 
machine id is displayed during installation, and can be viewed again by selecting 
About in the Hollywood FX dialog, or by selecting Programs->Hollywood FX-
>Enter Your Permanent key Code from the Start Menu. 
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CCuussttoommeerr  SSuuppppoorrtt  
Pinnacle Systems is dedicated to providing the best products and the best customer 
support. 

You can receive free customer support at any time by sending email to 
support@hollywoodfx.com.  You can also look for updated support information in 
the Support area of our web site at www.hollywoodfx.com.   

Please note Pinnacle Systems cannot provide support for using your video editing 
software.  You should first make sure you fully understand the operation of your 
other software before calling.  You should also look through the Readme file and the 
Troubleshooting section of this guide before calling. 

Hollywood FX Technical Support 
Pinnacle Systems 
280 North Bernardo Avenue 
Mountain View, CA 94043 
 
Customer Support:  1-650-237-1800 
Fax:   1-650-930-1630 
Email:   support@hollywoodfx.com 
World Wide Web:  www.hollywoodfx.com 
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  HHoosstt  AApppplliiccaattiioonnss  
This chapter provides quick-start documentation for each video editor (host 
application) that Hollywood FX plugs into.  For each host application, the basic 
procedure is described for adding and modifying Hollywood FX transitions, as well as 
hints and tips specific to that video editor.  After reading the section describing your 
video editor, you should continue to the tutorials in the following sections. 
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AAddoobbee  AAfftteerr  EEffffeeccttss  
Hollywood FX can be used as an effect for any layer in Adobe After Effects.  
Hollywood FX will always use the selected layer as Source 1 in the FX.  Additional 
layers can be selected that will be used as the other sources in an FX. 

CCrreeaattiinngg  AA  HHoollllyywwoooodd  FFXX  TTrraannssiittiioonn    
You create a traditional A/B transition by attaching Hollywood FX to the “A” layer, 
then select the “B” layer as Source 2.  First, set up the two layers. 

··  TToo  pprreeppaarree  vviiddeeoo  cclliippss  ffoorr  aa  ttrraannssiittiioonn..  
F Place the “B” video clip for the transition into the composition. 
F Place the “A” video clip for the transition into the composition, then in the timeline 

window, adjust the times so that they overlap. 

 

Two video clips placed for a transition. 

F Select the “A” layer, and move the time indicator to the time that you want the transition 
to begin.   

F Select Split Layer in the Edit menu to create Razor tool and split the video clip on V2 at 
the beginning of the transition. 

 

Splitting the “A” video clip. 

You are now ready to apply Hollywood FX to the split portion of the “A” layer. 
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··  TToo  AAdddd  HHoollllyywwoooodd  FFXX  
F Select track 2 in the timeline. 
F From the Effect menu, select Hollywood FX->Hollywood FX 4.  The Hollywood FX dialog 

will appear.  You can select a transition and set your rendering options.  Click Ok in the 
Hollywood FX dialog when ready. 
Now, we need to select the “B” video source. 

··  TToo  SSeett  SSoouurrccee  22  ooff  tthhee  TTrraannssiittiioonn  
F In the Effect Controls dialog, click on the Source 2 dropdown, and select the layer from 

the composition that you wish to be the second video source. 

 
The Second Source is now selected. 

CCrreeaattiinngg  AA  TTrraannssiittiioonn++  
Setting up a Transition+ is extremely simple.  After setting up a standard A/B 
transition (as in the previous section), you will add any additional video sources to 
the composition, then select them in the “Source X Layer” controls. 

··  TToo  AAdddd  TThhee  AAddddiittiioonnaall  VViiddeeoo  SSoouurrcceess  
F After setting up the transition, add any additional layers to the composition (they can be 

dragged into the composition, but left offscreen). 
F Select each layer in the Source X Layer dropdowns in the Effect Controls window. 
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Additional video sources mapped for a Transition+. 

CCrreeaattiinngg  aa  MMuullttiiWWiinnddooww  EEffffeecctt  
MultiWindow effects do not transition from an “A” source to a “B” source.  Instead 
they allow picture-in-picture effects and other interesting results where you simply 
have motion paths for different video over a backdrop.  These MultiWindow effects 
are very easy to setup in Adobe After Effects. 

··  TToo  pprreeppaarree  ffoorr  aa  MMuullttiiWWiinnddooww  eeffffeecctt  
F Drag the video clips you want into the transition in reverse order (the backdrop first and 

the Source 1 video last).  Generally the backdrop source will continue in time before and 
after the Hollywood FX. 

 

The timeline, ready for a MultiWindow effect  

You are now ready to select a Hollywood FX effect. 
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··  TToo  AAdddd  HHoollllyywwoooodd  FFXX  
F Make sure the Source 1 layer is highlighted. 
F  From the Effect menu, select Hollywood FX->Hollywood FX 4. 
F The Hollywood FX dialog will appear, where you can select an effect and set options for 

rendering that effect.  Try selecting the Flip 4 effect in the MultiWindow Effects (2) 
group.  Click Ok in the Selection dialog when ready. 
Now we need to map each layer into a video source for the Hollywood FX effect. 

··  TToo  mmaapp  eeaacchh  llaayyeerr  iinnttoo  tthhee  FFXX..  
F Click on each Source Layer dropdown in the Effect Controls window, and select the 

corresponding layer for that source in the effect. 

 

The additional video sources selected. 
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AAddoobbee  PPrreemmiieerree  
Hollywood FX appears at the top of the Transitions window in Adobe Premiere.  If it 
does not appear see Troubleshooting for more information. 

Before adding a Hollywood FX transition, prepare two video sources on the A and B 
tracks of the timeline, so that there is some overlap between the two video clips. 

 
Two video clips ready for a Hollywood FX transition 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Make sure the Transitions window is visible.  If not, select Transitions from the Windows 

menu. 
F Drag Hollywood FX 4 from the Transitions window into the Transition track of the 

Construction window so that it is between the two video clips (the transition should 
automatically snap to fill the time between the two clips. 

F Double-click on the transition block. The Hollywood FX dialog should appear. 
The Hollywood FX dialog will appear, letting you choose a specific transition, and 
change options for your transition. 

 
A Hollywood FX transition in the timeline 
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CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in the T track. 
F The Adobe Premiere Transition Settings dialog will appear. 
F Click on Custom… to display the Hollywood FX dialog. 
F Make your changes in the Hollywood FX dialog. 

 
The Adobe Premiere Transition Settings Dialog 

SSppeecciiaall  FFeeaattuurreess  
In the Adobe Premiere Transition Settings Dialog you can use the Start and End 
sliders to adjust the starting and ending point of the transition.  You can create 
interesting results by ending one transition at 50% and starting the next at 50% to 
create a transition that is a combination of two separate transitions. 

Use sliders to 
adjust start and 

end point of 
transition. 

Click here to 
display the 

Hollywood FX 
dialog. 
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AAppppllee  FFiinnaall  CCuutt  PPrroo  
Final Cut Pro supports the Adobe After Effects plugin standard for 3rd party plugins, 
so Hollywood FX can only be used as a filter on a video clip in the timeline.  However, 
using the methods described in the following sections, it is a simple matter to create 
a transition, Transition+ and MultiWindow effect using Final Cut Pro. 

CCrreeaattiinngg  AA  HHoollllyywwoooodd  FFXX  TTrraannssiittiioonn    
Before adding a Hollywood FX transition, you must first add a 2nd video track (Ctrl-
click in the timeline and select Add Track).  

··  TToo  pprreeppaarree  vviiddeeoo  cclliippss  ffoorr  aa  ttrraannssiittiioonn..  
F Place the “A” video clip for the transition on Video Track 2. 
F Place the “B” video clip for the transition on Video Track 1.  It should start at the position 

in time where you want the transition to begin. 

 

Two video clips placed for a transition. 

F Select the Razor tool and split the video clip on V2 at the beginning of the transition. 

 

Splitting the “A” video clip. 

You are now ready to apply Hollywood FX to the clip on V2 where the transition will 
occur. 
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··  TToo  AAdddd  HHoollllyywwoooodd  FFXX  
F Select the Effects tab in the Browswer window. 
F Open the Filters, AE Effects and 3D Transitions and Effects folders. 
F Drag HollywoodFX 4 from the Browser window onto the second portion of the split clip in 

the V2 track (this is the clip that overlaps the video below it on V1). 
F Double-click on the clip in V2 so that it is active in the Viewer window. 
F Click on the Filters tab in the Viewer Window. 
F Click on the Options… button to display the Hollywood FX Selection dialog.  The Hollywood 

FX Selection dialog will appear, where you can select a transition and set options for 
rendering that transition.  Click Ok in the Selection dialog when complete. 
We have “tricked” Final Cut Pro into creating a transition by simply filtering the “A” 
clip and compositing it over the top of the “B” clip.  As the “A” clip flies off screen, 
the “B” clip is revealed below it. 

CCrreeaattiinngg  AA  TTrraannssiittiioonn++  
Final Cut Pro makes it simple to add additional sources for a Transition+.  You will 
set up your video clips similarly to a standard transition, with one additional step. 

··  TToo  pprreeppaarree  vviiddeeoo  cclliippss  ffoorr  aa  ttrraannssiittiioonn..  
F Place the “A” video clip for the transition on Video Track 2. 
F Place the “B” video clip for the transition on Video Track 1.  It should start at the position 

in time where you want the transition to begin. 
F Select the Razor tool and split the video clip on V2 at the beginning of the transition. 

Because we need the second video clip integrated into the transition rather than 
simply composited, you will cut the second clip and use the cut portion in Hollywood 
FX rather than on the timeline. 

··  CCoonnttiinnuuee  ttoo  pprreeppaarree  vviiddeeoo  cclliippss  ffoorr  ttrraannssiittiioonn  
F Move the playhead to the end of the “A” clip (the end of the transition). 
F Use the Razor tool to split the “B” clip at that time. 
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Splitting the “B” video clip. 

F Drag the first portion of the split “B” clip (the portion that is under the “A” clip) into your 
Browser window.  We will use this clip in a moment. 

 

The timeline, ready for Hollywood FX 

You are now ready to apply Hollywood FX to the clip on V2 where the transition will 
occur. 

··  TToo  AAdddd  HHoollllyywwoooodd  FFXX  
F Select the Effects tab in the Browser window. 
F Open the Filters, AE Effects and 3D Transitions and Effects folders. 
F Drag Hollywood FX 4 from the Browser window onto the second portion of the split clip 

in the V2 track (this is the clip that overlaps the video below it on V1). 
F Double-click on the clip in V2 so that it is active in the Viewer window. 
F Click on the Filters tab in the Viewer Window. 
F Click on the Options… button to display the Hollywood FX dialog.  You can select a 

transition and set options for rendering that transition.  Try selecting the Box6srce 
transition in the MultiWindow Transitions group.  Click Ok when ready. 
Our final step is to place our split “B” clip back into the transition, and to add any 
additional sources. 
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··  TToo  AAdddd  SSoouurrccee  22  ttoo  tthhee  TTrraannssiittiioonn  
F Drag the split portion of the “B” clip from the browser (this is the clip we trimmed and 

dragged into the browser earlier) onto the Source 2 Clip Control in the Viewer window. 

 

Dragging the “B” clip into the Source 2 Clip Control 

Notice that the Canvas window is updated to show the second video source on the 
cube.  Finally, you should continue to add video sources to the Clip Controls.  These 
Clip Controls correspond to the video sources of the transition.  In the case of the 
Box6srce transition, there are a total of 7 sources (6 on the cube, and the 
backdrop). 

··  TToo  AAdddd  AAddddiittiioonnaall  CClliippss  ttoo  tthhee  TTrraannssiittiioonn  
F Drag additional video clips from the Browser window into the Clip Controls in the Viewer 

window. 
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Dragging additional clips onto the Clip Controls 

This time rather than overlaying the filtered “A” clip onto the “B” clip, you actually 
include the “B” clip as part of the transition.  You also added additional clips for a 
Transition+.  Final Cut Pro makes this extremely simple with its drag-and-drop clip 
controls. 

CCrreeaattiinngg  aa  MMuullttiiWWiinnddooww  EEffffeecctt  
MultiWindow effects do not transition from an “A” source to a “B” source.  Instead 
they allow picture-in-picture effects and other interesting results where you simply 
have motion paths for different video over a backdrop.  These MultiWindow effects 
are very easy to setup in Final Cut Pro. 

··  TToo  pprreeppaarree  ffoorr  aa  MMuullttiiWWiinnddooww  eeffffeecctt  
F Drag the video clip you want as the backdrop onto the V1 track. 
F Drag the video clip that will be they correspond to Source 1 in the effect onto the V2 

track in the timeline. 
F Double-click on the clip in the V2 track so that it is visible in the Viewer window. 
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The timeline, ready for a multiwindow effect  

You are now ready to select a Hollywood FX effect. 

··  TToo  AAdddd  HHoollllyywwoooodd  FFXX  
F Select the Effects tab in the Browser window. 
F Open the Filters, AE Effects and 3D Transitions and Effects folders. 
F Drag Hollywood FX 4 from the Browser window onto the clip in V2. 
F Click on the Filters tab in the Viewer Window. 
F Click on the Options… button to display the Hollywood FX dialog.  You can select an effect 

and set options for rendering that effect.  Try selecting the Spin4 effect in the 
MultiWindow Effects (1) group.  Click Ok when ready. 
Our final step is to add any additional video sources.  Because we are compositing 
the effect onto a backdrop in V1 we do not need to place a video clip in the Source 5 
clip control (which corresponds to the backdrop in the effect). 

··  TToo  AAdddd  AAddddiittiioonnaall  CClliippss  ttoo  tthhee  TTrraannssiittiioonn  
F Drag additional video clips from the Browser window into the Clip Controls in the Viewer 

window. 
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AAvviidd  MMeeddiiaa  CCoommppoosseerr,,  XXpprreessss,,  aanndd  SSyymmpphhoonnyy  
Avid’s AVX plugin structure allows for the ultimate in flexibility with Hollywood FX.  
Hollywood FX can be used as a single image filter, a transition, or for MultiWindow 
effects directly within the timeline. The following sections describe the process for 
using Hollywood FX in Avid AVX compatible products. 

AAddddiinngg  AA  HHoollllyywwoooodd  FFXX  TTrraannssiittiioonn    
To add a Hollywood FX transition to the Avid timeline, first add two video sources 
that you want to transition between, and trim as necessary to create time for the 
transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Open the Effect Palette (z-8 or Ctrl-8).  
F Select the Hollywood FX group from the left side of the Effect Palette. 
F Drag HFX 02 Sources from the right side of the Effect Palette into the timeline, 

between the two video clips. 
F Once dropped into the timeline, switch to Effect Mode (so that the Effect Editor window 

is open, and click on the small button icon to the right of HFX 02 Sources.  

 

Hollywood FX in the Avid Effect Palette 

The Hollywood FX dialog will appear, letting you choose a specific FX, and set the 
options for rendering that FX. 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected FX 
or any options. 
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A Hollywood FX transition in the Avid Timeline 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Switch to Effect Mode. 
F Click on the plugin icon in timeline. 
F Click on the button icon to the right of HFX 02 Sources in the Effect Editor window. 
F Make your changes in the Hollywood FX Selection dialog. 

AAddddiinngg  AA  HHoollllyywwoooodd  FFXX  FFiilltteerr    
Hollywood FX can also be used as a filter for a single video source in Avid AVX 
compatible products.  

··  TToo  aadddd  aa  ffiilltteerr  ttoo  tthhee  ttiimmeelliinnee::  
F Open the Effect Palette (z-8 or Ctrl-8).  
F Select the Hollywood FX group from the left side of the Effect Palette. 
F Drag HFX 01 Source from the right side of the Effect Palette into the timeline, on top 

of the video you wish to filter. 
F Once dropped into the timeline, make sure the Effect Editor window is open, and click on 

the small button icon to the right of HFX 01 Source.  

 

Hollywood FX in the Avid Effect Editor 

The Hollywood FX dialog will appear, letting you choose a specific FX, and set the 
options for rendering that FX. 

CChhaannggiinngg  aann  EExxiissttiinngg  FFiilltteerr  
You can modify a filter that is already in the timeline, changing the selected FX or 
any options. 

··  TToo  cchhaannggee  aa  ffiilltteerr  iinn  tthhee  ttiimmeelliinnee::  
F Switch to Effect Mode (opening the Effect Editor window). 
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F Click on the plug icon that represents the filter in the timeline. 
F Click on the button icon to the right of HFX 01 Source in the Effect Editor window. 
F Make your changes in the Hollywood FX Selection dialog. 

AAddddiinngg  AA  HHoollllyywwoooodd  FFXX  MMuullttiiWWiinnddooww  EEffffeecctt    
Avid’s nested track capability makes it simple to use Hollywood FX’s MultiWindow 
effects in your projects.  

··  TToo  aadddd  aa  MMuullttiiWWiinnddooww  ttoo  tthhee  ttiimmeelliinnee::  
F Open the Effect Palette (z-8 or Ctrl-8).  
F Select the Hollywood FX group from the left side of the Effect Palette. 
F Drag HFX XX Source which matches the number of sources in the effect you will use 

from the right side of the Effect Palette into the timeline, on top of a piece of video in 
timeline which will serve as the backdrop of the effect.  For example, if you wanted to 
create the Box6srce effect, you would drag the HFX 07 Source effect onto your video 
clip. 

F Once dropped into the timeline, make sure the Effect Editor window is open, and click on 
the small button icon to the right of HFX XX Source.  

F The Hollywood FX Selection dialog will appear.  Select the effect you wish to use and set 
any rendering options, then click Ok. 

F Next, double-click on the plugin icon on the timeline to open up the nested tracks.  
F Switch to Source/Record mode or Trim mode, then drag additional video clips into the 

nested tracks.  The nested track number corresponds to the Source number in HFX. 

 

Hollywood FX in the Avid Effect Editor 
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AAvviidd  MMCCXXpprreessss  
Hollywood FX can be used as a transition or as a filter in Avid MCXpress. 

AAddddiinngg  AA  HHoollllyywwoooodd  FFXX  TTrraannssiittiioonn  
To add a Hollywood FX transition to the timeline, first prepare two video sources and 
trim as necessary to allow a transition between them. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Double-click between the two video sources to display the Transition Editor dialog. 
F Select the Hollywood FX Inc Category. 
F Select Hollywood FX 4 from the list of Effects. 
F Click on the Custom button. 

The Hollywood FX dialog will appear, letting you choose a specific transition, and set 
the options for rendering that transition.  

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected FX 
or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the effect (between the two video clips). The MCXpress Transition Editor 

will appear. 
F Click on Custom and the Hollywood FX dialog will appear. 
F Make your changes in the Hollywood FX dialog and click Ok when finished. 
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CCaannooppuuss  RReexx  EEddiitt  
To add A Hollywood FX transition to the Rex Edit timeline, first add the two video 
clips to the timeline that you want to transition between. 

 
Two clips ready for A Hollywood FX transition 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee  
F Right-click between the two video clips and select Transition->1 second from the popup 

menu. A transition block will now appear indicating the transition. 

 
The transition block in the timeline 

F Right-click on the transition block and select Settings from the popup menu.  The Rex 
Edit Transition dialog will appear. 

F Click on Hollywood FX in the list of transitions. 
F Click on Configure. 

The Hollywood FX dialog will appear, letting you choose a gradient and transition 
options. 

Right-click on the 
transition block to 

display the popup menu. 
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The Rex Edit Transition dialog 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options for that transition. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Right-click on the transition block in the timeline and select Settings from the popup 

menu. 
F Click on Config in the Rex Edit Transition dialog to display the Hollywood FX dialog. 

You can change the 
duration of the 
transition here. 

Click Config to 
display  the 

Hollywood FX 
Dialog. 
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DDiissccrreeeett  LLooggiicc  EEddiitt**  
The following procedure describes the steps required to setup a Hollywood FX 
transition in Discreet Logic Edit.  The procedure described here is slightly different 
than that described in the Edit manual in the Using Software Plug-In Effects 
section.  Both methods achieve the same results, but the method described here 
requires less steps. 

··  TToo  PPrreeppaarree  TThhee  VViiddeeoo  EEvveennttss  FFoorr  HHoollllyywwoooodd  FFXX  
F Make sure you have two video tracks and one DVE track in the Timeline, and make sure 

you are in Overrecord mode. 
F Make sure the V1 track is tabbed, and place the first video clip to video track V1. 

 
First video clip in the timeline. 

F Set the Timeline Cursor to the time where you want the transition to begin, and make 
sure the V2 track is tabbed. 

F Drag the second video clip onto video track V2 so that its start snaps to the timeline 
cursor. 

 
Second video clip in the timeline. 

You are now ready to add a Hollywood FX transition to the timeline. 

··  TToo  AAdddd  HHoollllyywwoooodd  FFXX  ttoo  TThhee  TTiimmeelliinnee  
F Right-click theTimeline, then choose Effects->Software Plug-In Effects from the 

popup menu. 
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F Set the duration of the transition (this can be changed by dragging the transition in the 
DVE track later). 

F Select Hollywood FX 4 in the Effects dialog then click on the Custom Settings button to 
display the Hollywood FX dialog. 

F Select a transition and set your options, then click Ok to exit Hollywood FX (see the next 
chapter for detailed information on using the Hollywood FX dialog). 

F Click Apply to apply the effect to the Timeline. 
Finally, you will split the V2 video clip, and move the remaining video (after the 
transition) up to the V1 track. 

··  TToo  sspplliitt  tthhee  vviiddeeoo  aanndd  rreennddeerr  tthhee  ttrraannssiittiioonn..  
F Move the Timeline Cursor to the end of the transition event on the DVE track. 
F Make sure that only the V2 track is tabbed then select Edit->Split Events from the 

menus. 

 
Second video clip split at end of the Hollywood FX transition 

F Tab the V1 track, then drag the split portion of the video clip on V2 up to V1. 

 
Hollywood FX transition ready to render 

F Render the transition by selecting Tools->Build DVEs->Current 



HHoollllyywwoooodd  FFXX  GGeettttiinngg  SSttaarrtteedd  

38 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options for that transition. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Place the Timelne cursor at the beginning of the transition event in the DVE track of the 

Timeline. 
F Right-click in the Timeline and select Effects->Software Plug-In Effects to display the 

Effects dialog. 
F Click the Trace button to retrieve the settings. 
F Click the Custom Settings button to display the Hollywood FX dialog. 
F Make your changes then click Ok to leave the Gradient Wizard. 
F Click Apply to apply the new settings to the Timeline. 

 
The Edit Effects Dialog 

 

Set transition 
duration here. 

Change the 
start/end 

point of the 
transition 

Click to 
display the 

Hollywood FX 
dialog. 

Change transition 
direction here. 

Click Trace to 
retrieve current 

settings. 

Click to apply 
changes to timeline. 
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DDPPSS  VViiddeeoo  AAccttiioonn  &&  VVeelloocciittyy  
To add a Hollywood FX transition to the timeline, first drag two video clips from the 
gallery into the V1 and V2 tracks of the timeline, overlapping the clips in time to 
create a transition. 

··  TToo  sseelleecctt  aa  HHoollllyywwoooodd  FFXX  ttrraannssiittiioonn::  
F Right-click on the transition block in the X track of the timeline. 
F Select Rendered Transitions->Plugin Transitions from the popup menus. 
F Select Hollywood FX 4 from the selection dialog. The Transition Viewer will now appear. 
F Click on Custom to display the Hollywood FX dialog. 

Once the Hollywood FX dialog appears you can select a gradient and set your 
transition options. 

 
A Hollywood FX transition in the timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the transition block in the X track. 
F The Transition Viewer dialog will appear. 
F Click on Custom to display the Hollywood FX dialog. 
F Make your changes in the Hollywood FX dialog. 

Double-click here to 
render the 
transition. 
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The Transition Viewer Dialog 

SSppeecciiaall  FFeeaattuurreess  
Use the Start and End sliders to adjust the starting and ending point of the transition.  
You can create interesting results by ending one transition at 50% and starting the 
next at 50% to create a transition that is a combination of two separate transitions. 

 

Use this slider 
to adjust the 
start point of 
the transition. 

Use this slider 
to adjust the 

end point of the 
transition. 

Click here to 
display the 

Gradient Wizard 
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FFAASSTT  660011  &&  SSoonnyy  EEddiittSSttaattiioonn  EESS--33  
To add a Hollywood FX transition to the timeline, first add two video sources that you 
want to transition between, and trim as necessary to create time for the transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F In your Project window you will find the Hollywood FX 4 transition icon in the Added 

folder under Plugin Transition FX.  

 
The Hollywood FX 4 icon in the Plugin Transitions FX/Added Folder 

F Drag the Hollywood FX 4 transition icon from the Project window into the timeline, and 
drop it between the two video clips you have prepared.  The transition will now be 
represented on the timeline. 

F Right-click on the transition in the timeline, then select Edit from the popup menu.  The 
FAST/Sony Transition Options dialog will appear. 

F Click on Custom button.  
The Hollywood FX dialog appears, letting you choose a transition and transition 
options. 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Right-click on the transition in the timeline, select Edit from the popup menu.  The 

FAST/Sony Transition Options dialog will appear. 
F Click on Custom to display the Hollywood FX dialog. 
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The Transition Options dialog. 

SSppeecciiaall  FFeeaattuurreess  
Use the Start and End sliders to adjust the starting and ending point of the transition.  
You can create interesting results by ending one transition at 50% and starting the 
next at 50% to create a transition that is a combination of two separate transitions. 

You can also use the Divide By controls to create an array of gradient wipes for the 
transition. 

Click here to 
display the 

Hollywood FX 
dialog. 

Use these sliders 
to change the 
starting and 

ending position of 
the transition.. 

Create exciting 
arrayed 

transitions with 
the Divide By’s. 
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FFAASSTT  VViiddeeoo  MMaacchhiinnee  PPlluuss  
Hollywood FX appears in the Adobe FX group in FAST Video Machine Plus.  If it does 
not appear, see the Troubleshooting chapter for more information. 

To add a Hollywood FX transition to the timeline, first add two video sources that you 
want to transition between to the A and B tracks of the timeline, overlapping the two 
clips in time. 

 
Two video clips ready for a Hollywood FX transition 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Drag the Hollywood FX 4 icon from the Adobe FX group into the FX track of the 

timeline, between the two video clips. 
The Hollywood FX dialog appears, where you choose an FX and set options. 

 
A Hollywood FX transition in the timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options. 
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··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in the FX track of the timeline.  The 

FAST Transition Settings dialog will appear. 
F Click on Options and the Hollywood FX dialog will appear. 

 
The Transition Options Dialog 

SSppeecciiaall  FFeeaattuurreess  
Use the Start and End sliders to adjust the starting and ending point of the transition.  
You can create interesting results by ending one transition at 50% and starting the 
next at 50% to create a transition that is a combination of two separate transitions. 

You can also use the Divide By controls to create multiple copies of the transition on 
the screen. 

 

Click here to 
display the 

Hollywood FX 
dialog. 

Change the 
start/end points 
of the transition 

Use Divide by’s to 
create cool array 

transitions. 
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IIMMCC  IInncciittee  
Hollywood FX appears in the Keyframe-Filters tab for a clip.  If it does not appear, 
see the Troubleshooting chapter for more information. 

 
Hollywood FX in IMC Incite 

To add a Hollywood FX transition to the timeline you first need to prepare two video 
clips for the transition. 

··  TToo  pprreeppaarree  vviiddeeoo  cclliippss  ffoorr  aa  ttrraannssiittiioonn::  
F Add the first video clip to the OVL track. 
F Add the second video clip to the A/B track, overlapping the first video clip in time, so 

that the overlap between the two clips is the amount of time you want for the duration fo 
the transition. 

F Click on the video clip in the OVL track so that it is selected. 
F Move the Positioner to the exact start of the video clip on the A/B track. 

 
Two video clips added to the timeline. 
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You need to split the first video clip using the Cut tool.  

··  TToo  ccuutt  tthhee  ffiirrsstt  vviiddeeoo  cclliipp::  
F Click on the Cut tool to split the video clip in the OVL track at the start of the transition. 
F Click on the segment of video in the OVL track that overlaps the video on the A/B track. 

Your video is now ready for a Hollywood FX transition. 

 
Ready to add Hollywood FX 

··  TToo  aadddd  aa  HHoollllyywwoooodd  FFXX  ttrraannssiittiioonn::  
F Click on the Keyframe tab then on the Filters sub-tab.  In the listing on the left you 

should see Hollywood FX 4. 
F Double-click on Hollywood FX 4 to add it to the clip. 

The Hollywood FX dialog appears, letting you choose a transition and transition 
options. 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected FX 
or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Click on the video clip in the OVL track that has Hollywood FX attached as a filter. 
F Click on the Keyframe tab then on the Filters sub-tab. 
F Double-click on the Hollywood FX 4 item listed on the right-side listing. 
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IInn--ssyynncc  SSppeeeedd  RRaazzoorr  
Before using Hollywood FX in a project, you need to add it to the library. 

··  TToo  AAdddd  HHoollllyywwoooodd  FFXX  TToo  TThhee  LLiibbrraarryy::  
F Left-click in the Library window, then select Add Transitions… from the menu. 
F Change to the Trans directory within Razor. 
F Double-click on Hfx4.tra.  The Hollywood FX 4 transition icon should appear in your 

library window. 

 
Hollywood FX in the Razor Library 

AAddddiinngg  HHoollllyywwoooodd  FFXX    
To add a Hollywood FX to the Razor timeline, first add two video sources that you 
want to transition between to the timeline.  You should leave one track between the 
two clips and you should overlap the two clips in time to create the amount of time 
for the transition you wish. 

 
Two video clips ready for a Hollywood FX transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Drag the Hollywood FX 4 icon from the library into the timeline so that it snaps between 

the two video clips. 
As soon as you drop the Hollywood FX icon into the timeline, the Hollywood FX dialog 
will appear, letting you choose the FX and set options for the transition. 
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Hollywood FX in the Speed Razor timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in timeline.  The Hollywood FX dialog 

will appear. 
F Make any changes then click Ok to complete. 
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MMeeddiiaa  110000  ((MMeeddiiaa  110000  aanndd  FFiinniisshh))  
Hollywood FX appears in the DVEs group in Media 100.  If it does not appear, see the 
Troubleshooting chapter for more information. 

To add a Hollywood FX transition to the timeline, first add two video sources that you 
want to transition between the a and b tracks of the timeline, overlapping the two 
clips in time. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Hold down the SHIFT key, and then click on the Cut Down Arrow between the two video 

clips, and drag to the right, creating a new transition.  Drag all the way to the right so 
that the transition fills the overlap between the two clips. 

F Double-click on the Transition block in the fx track.  The Edit Suite window should 
appear, and should be in Transitions mode. 

F Select the DVE transition group. 
F Select Hollywood FX 4 from the list of transitions. 
F Click on the Panel Expansion button to expand the Edit Suite window. 
F Click on Custom Settings…  The Hollywood FX dialog will appear. 
F Select an FX and set your options, then click Ok to return to the Edit Suite window. 
F Click Apply to accept your options. 

 
A Hollywood FX transition in the timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected FX 
and any options. 
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··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the “Hollywood FX 4” transition block in the fx track.  The Edit Suite 

window should appear. 
F Click on the Panel Expansion button in the Edit Suite. 
F Click on Custom Settings… 
F Make your changes in the Hollywood FX dialog then click Ok. 
F Click Apply in the Edit Suite window to accept the changes. 

 
The Edit Suite Window 

SSppeecciiaall  FFeeaattuurreess  
Use the Range sliders to adjust the starting and ending point of the transition.  You 
can create interesting results by ending one transition at 50% and starting the next 
at 50% to create a transition that is a combination of two separate transitions. 

 

This is the 
DVE group 

Select 
Hollywood FX 

from the 
popup. 

Remember to 
click Apply! 

This is the Panel 
Expansion button 

Control the 
start and end 

point 

Click here to 
display the 

Hollywood FX 
dialog 
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PPaannaassoonniicc  DDVVEEddiitt  
To add a Hollywood FX transition to the timeline, first add two AV or Vdo clips to the 
Video track of the Sequence Editor Timeline, and trim the clips to create margin for 
the transition (you should see a CUT icon below the Video track. 

 
Two clips ready for  Hollywood FX transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Double-click on the CUT icon below the video clips, to display the DVEdit Transition 

window.  
F Click on the EXT. EFFECT transition type icon above the display area in the Transition 

window.  The icons for any extended effects (including Hollywood FX) will be displayed. 
F Click on the Hollywood FX 4 icon in the display area. 
F Click on the Detail Settings button in the lower right of the Transition window.   

 
The DVEdit Transition window 

 

Click the 
Ext.Effects 

button to find 
Hollywood FX. 

Click on the 
Hollywood FX 

icon. 

Adjust the 
transition’s 
duration. 

Click here to 
display the 

Hollywood FX 
dialog. 
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The Hollywood FX dialog appears, letting you choose an FX and set options.  

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
gradient or any options. 

 
The Hollywood FX transition in the Sequence Editor Timeline 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the “Hollywood FX 4” transition icon in the Sequence Editor timeline.  The 

DVEdit Transition window will appear. 
F Click on the Detail Settings button in the lower right of the Transition window.  The 

Hollywood FX dialog will appear. 
F Make any desired changes in the Hollywood FX dialog then click Ok. 
F Click Ok in the Transition window to return to the Sequence Editor. 
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UUlleeaadd  MMeeddiiaa  SSttuuddiioo  PPrroo  
Hollywood FX appears in the Transition Effect section of the Production Library 
in Ulead Media Studio Pro.  If it does not appear, see Troubleshooting for more 
information. 

 
Hollywood FX in the Production Library 

To add a Hollywood FX transition to the timeline, first add two video sources that you 
want to transition between to the A and B tracks of the timeline, overlapping the two 
clips in time. 

 
Two video clips ready for A Hollywood FX transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Switch to Transition Effect in the Production Library. 
F Double-click on the HFX Inc drawer. 
F Drag the Hollywood FX icon from the HFX Inc drawer into the fx track of the timeline, 

between the two video clips.  The Transition Options window will appear. 
F Click on the Options button. 

The Hollywood FX appears, letting you choose a gradient and transition options. 
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A Hollywood FX transition in the timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the selected 
transition or any options for that transition. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in the fx track of the timeline.  The 

Transition Options dialog will appear. 
F Click on Options and the Hollywood FX dialog will appear. 
F Make your changes in the Hollywood FX dialog. 

 
The Ulead Transition Options dialog 

SSppeecciiaall  FFeeaattuurreess  iinn  MMeeddiiaa  SSttuuddiioo  PPrroo    
You can use the Divide By controls to create an array of gradient wipes for the 
transition. 

The keyframe controls can be used to control the transition degree during the 
duration of the transition.  This lets you do things like hold the transition halfway 
through or combine two partial transitions. 

Use Divide by to 
create exciting results. Click here to 

display the 
Hollywood FX 

dialog. 

Use the keyframe 
tools to create 

holds and partial 
transitions. 
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  TTuuttoorriiaall::  TTrraannssiittiioonnss  
&&  OOppttiioonnss  

• This tutorial will take you through the basics of selecting a Transition FX and 
setting Effect Options. 

··  TToo  pprreeppaarree  ffoorr  tthhiiss  ttuuttoorriiaall::  
F Set up two video clips in your host application and add Hollywood FX as described in 

Getting Started. 
F When the Hollywood FX dialog appears, you are ready to begin. 

 

 

The Hollywood FX dialog 

The Hollywood FX dialog is organized into panels.  The first panel is the Edit List, 
which is the central control for working with FX.  Selecting items in the Edit List 
brings up different Item panels on the right side of the dialog.  The second panel is 
the Monitor panel that displays the preview of the current FX.  Finally, the Item panel 
changes to show different options for the selected item in the Edit List. 
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SSeelleeccttiinngg  AAnn  FFXX  
When the Hollywood FX dialog is displayed, you will immediately see the FX Catalog 
(this is displayed when the current FX name is selected in the Edit List).  The FX 
Catalog has two major controls.  The FX Group popup list at the top of the page 
allows you to select one of the many groups of FX.  Below the FX Group list are the 
icons for each FX in the group.  For this tutorial you will select an interesting 
transition called Ball Split.  This FX is in the Basic Shape Transitions group. 

··  TToo  sseelleecctt  tthhee  BBaallll  SSpplliitt  FFXX::  
F Select 2 – Basic Shape Transitions from the FX Group popup list. 
F Click on the Ball Split FX icon. 

When you select this FX, hints and tips for that effect appear at the bottom of the FX 
Catalog panel. 

TThhee  MMoonniittoorr  PPaanneell  
Whenever you make changes in Hollywood FX, the preview window in the Monitor 
panel is updated.  Try dragging the slider directly below the preview to view different 
frames of the preview.   

You can also play the entire FX once by clicking on the play once button. 

You can have the preview play continuously as you work, by depressing the loop play 
button.  Press the loop play button a second time to stop the looping playback. 

The other controls on the Monitor panel will be described in later tutorials. 

EEffffeecctt  OOppttiioonnss  
Hollywood FX gives you quick and easy control over many FX options.  You can 
create new and exciting results without having to re-keyframe the entire FX. 

··  TToo  vviieeww  tthhee  EEffffeecctt  OOppttiioonnss::  
F Click on the Effect Options item in the Edit List panel. 
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The Effect Options panel selected 

Turn on continuous playback of the preview before we continue. 

··  TToo  ttuurrnn  oonn  ccoonnttiinnuuoouuss  ppllaayybbaacckk  ooff  tthhee  pprreevviieeww::  
F Click on the Loop Play button below the preview window in the Monitor panel. 

EEaassyy  FFlliigghhtt  OOppttiioonnss  
You can quickly change the flight path of an object in useful ways using the Easy 
Flight controls. 

··  RReevveerrssee  FFlliigghhtt::  
F Click on the Reverse Flight checkbox.  Watch the changes in the preview. 
F Click on the Reverse Flight checkbox to clear it. 

Watch the preview now.  You will see that instead of the first video source flying off 
and revealing the second video source, the second video source will fly on and cover 
the first video source. 

··  FFlliigghhtt  PPaatthh::  
F Click-and-drag the Flight Path dial so that it reads 45. Watch the preview. 
F Click on the Rotate Object checkbox so it is checked. Watch the preview. 
F Click-and-drag the Flight Path dial so that it reads 90. Watch the preview. 
F Click-and-drag the Flight Path dial so that it reads 0. You can also use the arrow keys to 

change the dial by one degree increments. 
The Flight Path dial rotates the entire flight path of the 3D objects in the FX, giving 
you a different result quickly and easily.  When you change the Flight Path, it does 
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not rotate the object itself.  Checking the Rotate Object checkbox will cause the 
object itself to rotate and “follow” the new path. 

EEaassyy  LLiigghhttiinngg  
Lighting, shadows and shine add incredible 3D realism to an FX.  By default all of 
these features are turned on.  Try turning them off to see the difference it makes. 

··  TToo  ttuurrnn  ooffff  LLiigghhttiinngg,,  SShhaaddoowwss,,  aanndd  SShhiinnee..  
F Click on the Shine checkbox to clear it.  Notice that the glossy shine disappears. 
F Click on the Shadows checkbox to clear it.  Notice that the shadow disappears. 
F Click on the Lighting checkbox to clear it.  Notice that the 3D ball is no longer shaded. 
F Click on Shine, Shadows, and Lighting to turn back on all of these features. 

In addition to being able to control which lighting features are used, you can also 
control the light direction.  By default, light comes from the top center of the 3D 
“world”. When you adjust the light direction, it automatically adjusts the shine and 
shadow position as well. 

··  LLiigghhtt  DDiirreeccttiioonn  ((BBrroonnzzee,,  SSiillvveerr,,  GGoolldd))::  
F Click-and-drag the Light Direction dial so that it reads 90. Watch the preview. 
F Click-and-drag the Light Direction dial so that it reads 180. Watch the preview. 
F Click-and-drag the Light Direction dial so that it reads 0. You can also use the arrow keys 

to change the dial by one degree increments. 
Changing the light direction to 180 degrees gives a very unique, almost sinister 
appearance. 

EEaassyy  OOppttiioonnss  
The Easy Options controls let you adjust special rendering features of the 3D engine. 

RReennddeerr  TTyyppee  ((BBrroonnzzee,,  SSiillvveerr,,  GGoolldd))  
Normally objects with curves are rendered with smooth surfaces.  You can use the 
Render Type to change to faceted or wire surfaces. 

··  RReennddeerr  TTyyppee::  
F Click on the Flat radio button under Render. Notice that the object no longer appears 

smooth. 
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F Click on the Wire radio button under Render.  Notice that the object is now rendered as 
a wireframe rather than a solid object. 

F Click on the Smooth radio button under Render to return to smooth solid rendering. 

AAnnttiiaalliiaassiinngg  
Because of the low resolution of video, sharp edged 3D effects will often exhibit 
blocky stairstepping along the edges of objects.  Antialiasing eliminates much of this 
problem.  Hollywood FX includes three methods of antialiasing (however the preview 
generally only displays edge antialiasing. 

··  AAnnttiiaalliiaassiinngg::  
F Click on Edge under Antialiasing and notice how the edges of the 3D ball are smoothed. 
F Click on Scene 2X under Antialiasing to switch to scene antialiasing.  This generally will 

not change the preview, but during final rendering full Scene antialiasing will be used. 
The additional checkboxes and advanced shadow controls are described in more 
detail in the Reference Guide. 

When you are ready, click Ok in the Hollywood FX dialog to exit, then render your 
project to see the results. 
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  TTuuttoorriiaall::  TTrraannssiittiioonn++  
(Bronze, Silver, Gold) In the previous tutorial you worked with a Transition FX 
which had only two video sources.  In this tutorial you will use a Transition+ FX 
that performs a transition, but has additional video sources you can use. 

When you are finished with this tutorial, you will know: 

• How to use a Transition+ FX with extra video sources. 

• You will also learn some of the features on the Settings dialog. 

··  TToo  pprreeppaarree  ffoorr  tthhiiss  ttuuttoorriiaall::  
F Set up two video clips in your host application and add Hollywood FX as described in 

Getting Started, creating a two second transition. 
F When the Hollywood FX dialog appears, you are ready to begin. 

SSeelleeccttiinngg  tthhee  TTrraannssiittiioonn++  
··  TToo  sseelleecctt  tthhee  ttrraannssiittiioonn::  
F Select MultiWindow Transitions from the FX Group popup list at the top of the page. 
F Click on the FlipOver 1to2 icon.   
F Click the Play Once preview button. 

Watch the preview.  Notice that while the video is flipping over, you can see black in 
the background.  There is a backdrop that is currently not visible, because no video 
source has been mapped to it.  We will now map that 3rd video source. 

MMaappppiinngg  AA  VViiddeeoo  CClliipp  ttoo  SSoouurrccee  33  
Now add a video clip to Source 3 so that the background is no longer black. 

··  TToo  aadddd  aa  vviiddeeoo  cclliipp  ttoo  SSoouurrccee  33::  
F Click on the Host Video 3 media item in the Edit List. 
F Click on the Select File button. 
F Using the file requester, select a video clip to use for Source 3. 
F Click on the Play Once button in the Monitor window. 
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You have selected a new video source and should be able to see it in the background 
as Source 1 flips over to Source 2.  You should also make sure the field interpretation 
is correct for this video. 

··  TToo  cchhaannggee  ffiieelldd  IInntteerrpprreettaattiioonn::  
F Click on the Interpret popup, and select the proper field interpretation for your video.  

For most video capture cards you will select Interlaced – Upper First or Interlaced – 
Lower First.  
While correct interpretation is not important in the preview, it will be important for 
final rendering.  If interpretation is not set correctly, the video in the background will 
playback incorrectly (it will jerk rather than playing smoothly). 

You can set a default value for Interpret in the Settings dialog. 

CChhaannggiinngg  tthhee  DDeeffaauulltt  IInntteerrpprreett    
··  TToo  cchhaannggee  tthhee  ddeeffaauulltt  IInntteerrpprreett  vvaalluuee::  
F Click on the Settings button at the bottom of the Hollywood FX dialog. 
F In the Settings dialog, click on Default Interpret (in the Edit Settings area). 
F Select the field interpretation that your video capture card uses. 
F Click Ok to close the Settings dialog. 

From now on, when you select a video file, the Interpret value will be correctly 
defaulted.  You will only need to change Interpret if you select a single image file, or 
video captured using a different video card. 
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  TTuuttoorriiaall::  
MMuullttiiWWiinnddooww  FFXX  

(Bronze, Silver, Gold) The final type of FX in Hollywood FX is the MultiWindow FX.  
MultiWindow FX do not perform a transition from one video source to another.  
Instead, they feature multiple video windows that fly on or off screen in various 
ways.  For this tutorial we will use the Flip 4 effect and we will reverse it, so that we 
have four video windows that fly on, and play over a backdrop. 

Important Note for Avid AVX, Adobe After Effects, and Apple Final Cut Pro users: 
Generally you will want to follow the directions in the Getting Started section for 
setting up MultiWindow FX, since these host applications provide special features for 
MultiWindow FX. 

When you are finished with this tutorial, you should know: 

• How to select video sources for a MultiWindow FX. 

• How to use Hold at Start and Hold at End. 

PPrreeppaarree  ffoorr  tthhee  TTuuttoorriiaall  
MultiWindow FX are designed differently from Transitions.  In a MultiWindow FX, the 
Source A (or 1) video from the host application is always used as the backdrop video.  
This makes it easy to layout the timeline so that you can have the backdrop video 
continue before or after the FX. 

··  TToo  pprreeppaarree  ffoorr  tthhee  ttuuttoorriiaall::  
F Start a new project. 
F Place the video you want to use as the backdrop on you’re A (or V1) video track, so that it 

starts at the beginning of the project, and runs for about five seconds. 
F Place a second video source on the B (or V2) video track, so that it starts about one 

second into the project, and has a duration of about three seconds. 
F Insert a Hollywood FX transition between the two clips so that the transition is from A 

to B. 
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The Hollywood FX transition in Premiere, ready for a MultiWindow FX 

SSeelleeccttiinngg  tthhee  FFXX  aanndd  SSeettttiinngg  OOppttiioonnss  
For this tutorial, you will select an effect called Flip 4, where four video sources fly 
off over a backdrop video. We want the video sources to fly on, so we will reverse 
the FX. 

··  SSeelleeccttiinngg  tthhee  FFlliipp  44  FFXX  aanndd  sseettttiinngg  ooppttiioonnss::  
F Select Multiwindow Effects 2 from the FX Group popup menu. 
F Select Flip 4 from the FX icons. 
F Click on the Effect Options item in the Edit List. 
F Click on the Reverse checkbox. 
F Click on the Play Once button in the Monitor panel. 

Notice that the A video source plays in the background, and the B video source is 
mapped to the top left video window. We will now select video clips for the three 
remaining video windows. 

··  TToo  mmaapp  tthhee  aaddddiittiioonnaall  vviiddeeoo  ssoouurrcceess::  
F Click on the Host Video 3 media item in the Edit List. 
F Click on Select File in the Media Options panel. 
F Select a video clip using the file requester. 
F Click on the Play Once button to see the preview with the new video source. 
F Click on the Host Video 4 media item in the Edit List. 
F Click on Select File in the Media Options panel. 
F Select a video clip using the file requester. 
F Click on the Host Video 5 media item in the Edit List. 
F Select a video clip using the file requester. 

This video will 
be the backdrop 

for the FX. 

This video will be 
mapped to the top 
left video window. 
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F Click on the Play Once button in the Monitor panel to see the preview. 
Because you set up the default Interpret value in the previous tutorial, you should 
not have to change it for each video source you selected above. 

UUssiinngg  HHoolldd  AAtt  EEnndd  
The way the FX is currently set up, the four video windows will fly on screen, and as 
soon as the last one is on screen, the FX will end, and all of the video windows will 
disappear.  Instead of this, we would like the video windows to remain on screen for 
a longer time while they play video. The Effect Options panel has two sliders, Hold at 
Start and Hold at End, that allow you to quickly change the amount of time spent on 
the first and last frame of the FX.  This is exactly what we need. 

··  TToo  cchhaannggee  tthhee  HHoolldd  aatt  EEnndd::  
F Click on the Effect Options item in the Edit List. 
F Drag the End slider (under Hold Times) to 30%. 
F Click the Play Once button in the Monitor panel to see the preview. 

Now all of the video windows will fly on during the first 70% of the total FX time, 
and will hold at their final position for the last 30% of the total time.  

Now exit the Hollywood FX dialog and render the FX to see the final results. 
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  CClluubb  HHoollllyywwoooodd  
When you register Hollywood FX online to get your permanent keycode, you will also 
receive a userid, password, and some initial credit that you can use in Club 
Hollywood, the Internet FX mall.  Browse through and order new FX that open a new 
world for Hollywood FX.  Once you have used your initial credit, you can purchase 
additional credit at any time and continually add new FX to your library. 

To use Club Hollywood you will need a web browser (like Microsoft Internet Explorer 
or Netscape Navigator), and a connection to the Internet.  Simply connect to the 
Hollywood FX website at http://www.hollywoodfx.com, then click on the Club 
option.  Follow the instructions there to access and use your Club Hollywood account. 
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  TTrroouubblleesshhoooottiinngg  
This section provides a list of common problems and their solutions.  If you can’t find 
an answer to your problem in this list, or in the ReadMe file that is created during 
setup, then contact Hollywood FX customer support for more help. 

Hollywood FX does not show up in my host application. 

During installation Hollywood FX will attempt to find all compatible host applications 
and install the proper plugin files for that application.  If Hollywood FX does not show 
up, try copying the files listed below from the Host Plugins folder (in 
HollywoodFX4) into the folder listed. 

Host Application Plugin File Copy To Folder 

Adobe Premiere 5.0 Premiere5\Fx-5Hfx4XXX.prm Premiere 5.0\Plug-Ins 

Adobe Premiere 4.2 Premiere\Fx-Hfx4 XXX.prm Premiere42\Plugins  

Avid Symphony and Xpress AVX\Hfx4XXX.avx Symphony\AVX_Plug-Ins 

Canopus RexEdit  RexEdit\Hfx4XXX.dll DVRex\Effect 

Discreet Logic Edit Premiere\Fx-Hfx4XXX.prm Edit\Plugins 

DPS Video Action NT Premiere\Fx-Hfx4XXX.prm VAProNT\Plugins 

FAST 601 Premiere\Fx-Hfx4XXX.prm Fast 601\Plugins\Transitions 

FAST Video Machine Plus Premiere\Fx-Hfx4XXX.prm VMStudio\vfx_plug 

IMC Incite Premiere5\Fx-5Hfx4XXX.prm Incite\Plugins 

In-sync Speed Razor Ksync\Hfx4XXX.tra Razor\Trans 

Media 100 Finish Premiere\Fx-Hfx4XXX.prm Media 100\Transitions\DVEs 

Panasonic DVEdit Premiere\Fx-Hfx4XXX.prm DVEdit\rndpi\type1 

Sony EditStation ES-3 Premiere\Fx-Hfx4XXX.prm Sony ES-3\Plugins\Transitions 

Ulead Media Studio Pro 5.2 MStudio\Hfx4XXX.vfx Media Studio Pro 5.2\vfx_plug 

Ulead Media Studio Pro 6.0 MStudio\Hfx4XXX.vfx Media Studio Pro 6.0\vfx_plug 

XXX is your product level, CPR for Copper, BRZ for Bronze, SLV for Silver, GLD for 
Gold. 
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My video editor crashes when I try to use Hollywood FX. 

This usually indicates a conflict with your 3D graphics card. First, try getting the 
latest drivers for your graphic card. If that does not resolve the problem, try the 
following. 

F From the Start menu, select Programs -> Hollywood FX -> FXmark Benchmark Utility. 
F When the FXmark dialog appears simply close the dialog immediately (by clicking on the X 

button at the top right side of the dialog) without running any tests. 
This will set Hollywood FX to use software only for rendering and will generally 
resolve most hardware compatibility problems. 

I never get a rendered transition, I just get the Hollywood FX Logo. 

This indicates that Hollywood FX was not able to use OpenGL to render the effect. 
Check the following items to resolve this problem: 

• Check to make sure the files Opengl32.dll and Glu32.dll are in your 
Windows\System folder (Winnt\System32).  If they are not present, 
Windows 95 users should download the OpenGL libraries from the Support 
area of the Hollywood FX website.  Windows 98, NT, and 2000 users should 
check their operating system installation, and reinstall any service packs. 

• Make sure you are using the very latest drivers for your graphic display card. 

• Click on the Settings button in the Hollywood FX dialog and try changing 
the Context Type to Offscreen Software.  If it is already set to 
Offscreen Software change it to Offscreen Hardware. 

When I select video or images in the Media Options panel I get a white 
object instead of video. 

Generally this indicates you have run low on memory.  If you are doing MultiWindow 
effects with more than 3 video sources, you should have a minimum of 128 MB of 
RAM.  If you are using images you scanned in, you should lower the resolution of 
those scanned images. 

I get color/brightness jumps at the start and end of my effect. 

This is normally caused because the rendered effect is being recompressed while the 
surrounding video is not.  Many non-linear editors have an option to Recompress 
Always or to turn off Smart Rendering.  If your non-linear editor does not have a 
Recompress Always option, you can usually solve the shift by adding a 
Brightness/Contrast filter to both the incoming video and outgoing video clips, but 
leave the Brightness/Contrast settings unchanged.  This will cause the video to be 
recompressed, but not changed. 


